Clear Gene
Molecular Isothermal SARS
CoV-2 Assay (MICA)
Instructions for users
Version 0.1.4

MICA is intended for the qualitative detection of SARS-CoV-2 nucleic acid from individuals
suspected of COVID-19 by a healthcare provider. MICA is only for use under the U.S. Food and
Drug Administration’s Emergency Use Authorization.

A. CONTACT INFORMATION
1. Contact Information
Clear Gene Inc.
930 Brittan Ave
San Carlos
CA 94070
(415) 742-9100
2. Product Support and Adverse Event Reporting
For product support, please visit cleargene.com/support or e-mail customercare@cleargene.com
For adverse event reporting, please visit cleargene.com/adverse-event-reporting
3. Inquiries and Customer Service
Please visit https://cleargene.com/QuoteRequest or e-mail customercare@cleargene.com to
inquire about the product.
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B. INTENDED USE
1. Intended Use
The Molecular Isothermal SARS CoV-2 Assay (MICA) Test is a molecular assay intended for the
qualitative detection of nucleic acid from SARS-CoV-2 in nasopharyngeal swabs collected from
individuals suspected of COVID-19 by a healthcare provider.
Results are for the identification of SARS-CoV-2 RNA. The SARS-CoV-2 RNA is generally
detectable in respiratory specimens during the acute phase of infection. Positive results are
indicative of the presence of SARS-CoV-2 RNA; clinical correlation with patient history and other
diagnostic information is necessary to determine patient infection status. Positive results do not
rule out bacterial infection or co-infection with other viruses. The agent detected may not be the
definite cause of disease. Laboratories within the United States and its territories are required to
report all positive results to the appropriate public health authorities.
Negative results do not preclude SARS-CoV-2 infection and should not be used as the sole basis
for patient management decisions. Negative results must be combined with clinical observations,
patient history, and epidemiological information.
Testing is limited to laboratories certified under the Clinical Laboratory Improvement
Amendments of 1988 (CLIA), 42 U.S.C. §263a, that meet requirements to perform high
complexity tests. The MICA Test and MICA Software are intended for use by qualified laboratory
personnel specifically instructed and trained in general PCR and in vitro diagnostic procedures.
The MICA Test and MICA Software are only for use under the Food and Drug Administration’s
Emergency Use Authorization.
Molecular Isothermal SARS CoV-2 Assay (MICA) Software provides a computer-based anlaysis
of the MICA Test, including anlaysis and interpretation of raw fluorescent data, interpretation of
plate and sample controls, interpretation of the test result status, and presentation of test results.
2. Special Condition for Use Statements
•
•
•

For Emergency Use Authorization (EUA) only
For prescription use only
For in vitro diagnostic use only

3. Special Instrument Requirements
The MICA Test has been validated on the Bio-Rad CFX 96 instrument with CFX MaestroTM 4.1
Software for Windows PC.
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C. MEASURAND
MICA detects two specific nucleic acid sequences from the genome of the SARS-CoV-2 virus.
One of the detected genes encodes a structural protein and the other encodes a non-structural
protein.
SARS CoV-2 Target 1 is a region of the SARS CoV-2 N gene that encodes the structural
nucleocapsid protein. The nucleocapsid protein of SARS CoV-2 is thought to function similarly
to the more extensively studied nucleocapsid protein of SARS-CoV, where it plays a fundamental
role during viral self-assembly by binding to nucleic acids and packaging the viral RNA genome
into a helical ribonucleocapsid.
SARS CoV-2 Target 2 is a region of the SARS CoV-2 Orf1a gene that encodes Non-structural
Protein 2 (nsp2). nsp2 is an RNA-binding protein involved in replication of the coronavirus
genome. The CoV-2 genome includes several open reading frames (Orf). Orf1a and Orf1b produce
two polyproteins, pp1a and pp1b. These polyproteins are cleaved by polyproteases to produce 16
non-structural proteins (nsp). nsp1, nsp2 and nsp3 are released after the protein cleavage of the Nterminus of the replicase polyprotein. This cleavage step is essential for the viral replication.

D. DEVICE DESCRIPTION AND TEST PRINCIPLE
1. Product Overview/Test Principle
MICA uses isothermal amplification technology to detect SARS-CoV-2 viral RNA. The test uses
two specific primer sets that are designed to uniquely detect two sequences SARS-CoV-2 RNA.
A spike-in extraction control (SIC) template and primers are used to ensure recovery from the
RNA isolation procedure.
The components in the MICA kit are used to set up isothermal amplification reactions in a 96-well
plate. MICA reactions contain a mixture of two recombinant enzymes: a reverse transcriptase and
a DNA polymerase. The plate is incubated at 65°C for 30 minutes. During the isothermal reaction,
the reverse transcriptase uses sequence-specific primers to generate cDNA. cDNA is amplified by
a thermostable DNA polymerase with strand displacement activity and no detectable 5’exonuclease activity. Unlike polymerases employed in PCR, the MICA polymerase displaces,
instead of degrading, previously synthesized DNA product as it catalyzes DNA polymerization.
MICA overcomes the limitations of the temperature gating that is required in thermocycling-based
reactions by using sequence-specific primers to generate an intermediate product. The stranddisplacing DNA polymerase can exponentially amplify the intermediate product at a single
reaction temperature.
The amplification products are detected using a green-fluorescent nucleic acid intercalating dye.
Fluorescence data are collected in the FAM/SYBR channel of the RT-PCR instrument.
Amplification kinetics are determined using fluorescent readings obtained at 15 second intervals.
A cutoff time of 30 minute is used to distinguish positive and negative reactions for all samples
and controls.
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2. Description of Test Steps
2.1 Product Description
A spike-in extraction control (SIC) is added to each upper respiratory specimen. Nucleic acids are
then isolated using commercially available magnetic bead-based or column-based RNA isolation
kits that are not included in the MICA kit.
The purified nucleic acids are added to an MICA Reaction Mix that consists of the MICA Master
Mix and one of two Primer Mixes. Each sample is analyzed using primer sets to detect SIC and
SARS CoV-2. The SARS CoV-2 primer mix contains primers to detect two regions of the SARS
CoV-2 genome; the intercalating fluorescence signal is positive if at least one region of the viral
genome is detected.
Each plate includes two replicates of the negative No-Template Control (NTCs) and two replicates
of the CoV-2 Template Control (CTC).
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2.2 General Considerations for the Test Procedure
1. DO NOT OPEN TUBES OR UNSEAL PLATES after a reaction is completed.
Isothermal amplification is extremely sensitive and creates abundant product relative to
methods like PCR. Immediately discard plates after amplification.
2. The manufacturer strongly recommends that amplification is only performed on equipment
located in secondary laboratory areas that are separated from areas dedicated to preparing
reactions. To avoid contamination of new reactions with products of previous reactions,
the manufacturer strongly recommends strict protocols that include changing gloves and
gowns and washing hands when leaving the dedicated amplification area.
3. Regularly decontaminate setup locations and equipment using chlorine bleach to avoid
potential carryover contamination. Use a nonionic surfactant (such as DNA AWAY™) to
decontaminate delicate equipment and metal surfaces. Do not use bleach on metal
surfaces.
4. RNase prevention protocols are recommended, including frequently changing gloves,
using RNase-free water and plasticware, and routine decontamination of surfaces and
equipment.
5. Perform all steps of the testing protocol according to established laboratory protocols.

2.3 Handling and storage
•

Store all reagents at –20°C (both unopened and in-use product). Use the reagents within 3
months once opened.

•

Prepare workstation for work with RNA. Use RNase inhibitors (e.g. RNaseZap™) and
precautions to avoid RNase contamination. Decontaminate work surfaces, equipment,
pipettes, vortex, microcentrifuge.

•

Isolated RNA should be kept on a cold block at all times. (See cold block requirements in
Section I.3: Components required but not included.)

•

Thaw all assay components and place on a cold block. Once thawed, keep reagents on a
cold block during assay set up.

2.4 Spike-In Control (SIC)
Before performing RNA isolation, add 2 µL of the Spike-In Control (SIC) Template to the
300 μL - 400 μL aliquot of each sample that will be used in the subsequent RNA extraction
procedure.
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2.5 RNA Extraction
a) Do not begin RNA extraction without first adding the Spike-in Control (SIC) (Section 2.4).
b) The MICA Kit does not include viral RNA extraction reagents. The MICA Kit has been
validated with the Quick-DNA/RNA™ Viral MagBead (Zymo Research, Cat no. R2141)
and is currently being validated with QIAamp® DSP virus kit (QIAGEN, Cat no. 60704).
•

If using the Quick-DNA/RNA™ Viral MagBead extraction kit, use 400 μL of sample
input and elute in 50 μL.

•

If using the QIAamp® DSP virus kit, use 300 μL of sample input and elute in 60 μL.

c) Extracted nucleic acids should be kept on a cold block and used immediately or stored at
-70°C for up to 1 month.
2.6 Prepare MICA Reaction Mixes
a) Vortex and briefly spin down the MICA reagents before each use. Keep enzyme mix on a
cold block during the entire test procedure. Other reagents can be thawed at room
temperature.
b) Determine the number of reactions (wells) to set up for the plate. Each sample is tested
using two primer sets: one for SARS CoV-2 and one for the Spike-in Control (SIC).
S = number of clinical samples to test on a given plate. Each sample is tested using
both SARS CoV-2 primers and SIC primers.
C = Four plate controls. Each plate includes two replicates of the CoV-2 Template
Control (CTC) and two replicates of negative template control. The plate
controls are tested using the SARS CoV-2 primers.
The number of reactions for the SARS CoV-2 primer set is given by
NCoV-2 = S + C
The number of reactions for the Spike-in Control (SIC) primer set is given by
NSIC = S
c) Prepare Reaction Mixes for each set of primers in a 1.5 mL microcentrifuge tube according
to Tables 1 and 2 below.
•

A 20 µL reaction will contain 8 µL of sample or template plus 12 µL of the appropriate
Reaction Mix.

•

The two NTC reactions will contain 8 µL of water plus 12 µL of the SARS CoV-2
Reaction Mix.

•

A 10% dead volume is recommended to account for residual volumes and potential
pipetting inaccuracies of manual pipettes.
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Table 1. MICA Reaction Mix Setup for SARS CoV-2 Primers
Volume
Per Reaction

Dead Volume Factor

Volume for Reaction Mix with
SARS-CoV-2 Primers

Master Mix (2X)

10 µL

1.10

11 µL x NCoV-2

SARS-CoV-2
Primer Mix (10X)

2 µL

1.10

2.2 µL x NCoV-2

Table 2. MICA Reaction Mix Setup for Spike-in Control (SIC) Primers
Volume
Per Reaction

Dead Volume Factor

Volume for Reaction Mix with
SIC Primers

Master Mix (2X)

10 µL

1.10

11 µL x NSIC

Spike-In Control
Primer Mix (10X)

2 µL

1.10

2.2 µL x NSIC

2.7 Prepare the plate
a) Considerations during the plating process
•

Always change pipette tips between patient samples and after pipetting each
component.

•

The CTC contains a high concentration of viral template. To avoid possible
contamination, add the CoV-2 Template Control (CTC) to the plate last.

•

Change gloves often to avoid cross contamination between samples and control
reagents.

b) Always keep the sample tubes on a cold block. Pipette 12 µl of MICA Rection Mix to each
well according to the Plate Layout in Table 3.
•

The MICA Reaction Mix consists of MICA Master Mix prepared with either the CoV2 Primer Mix or the SIC Primer Mix (see Section 2.6).

•

Every plate includes two wells with CoV-2 Template Control (CTC) and two wells
with negative control (no-template control, NTC). The CTC and NTC wells contain
Reaction Mix with CoV-2 Primer Mix.

•

Clear Gene’s MICA analysis software expects the CTC to be located in wells G11 and
G12, and the NTC to be located in wells H11 and H12, even if the plate contains fewer
than 46 samples.
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Table 3. Plate Layout for 46 clinical samples.
MICA Reaction Mix with SARS-CoV-2 Primers
MICA Reaction Mix with Spike-In Control Primers
Samples (Template = Isolated RNA)
CoV-2 Template Control (Template = SARS CoV-2 Plasmid)
No Template Control (Template = Water)

S1-S46
CTC
NTC

A
B
C
D
E
F
G
H

1
S1
S1
S13
S13
S25
S25
S37
S37

2
S2
S2
S14
S14
S26
S26
S38
S38

3
S3
S3
S15
S15
S27
S27
S39
S39

4
S4
S4
S16
S16
S28
S28
S40
S40

5
S5
S5
S17
S17
S29
S29
S41
S41

6
S6
S6
S18
S18
S30
S30
S42
S42

7
S7
S7
S19
S19
S31
S31
S43
S43

8
S8
S8
S20
S20
S32
S32
S44
S44

9
S9
S9
S21
S21
S33
S33
S45
S45

10
S10
S10
S22
S22
S34
S34
S46
S46

11
S11
S11
S23
S23
S35
S35
CTC
NTC

12
S12
S12
S24
S24
S36
S36
CTC
NTC

c) Pipette 8 µl of sample, template, or water to the appropriate wells according to the Plate
Layout in Table 3.
•

Gently vortex RNA samples and pipette 8 µL to the appropriate sample wells.

•

Gently vortex the CTC template and pipette 8 µL to CTC wells G11 and G12.

•

Pipette 8 µL of water to NTC wells H11 and H12.

d) Seal and centrifuge the plate.
•

Seal the PCR plate with adhesive sealing film. Use a flat edge or a roller to ensure that
the film completely seals each well of the plate.

•

Centrifuge the plate for 30 seconds at 500 x g using a microplate centrifuge to remove
potential air bubbles and spin the contents into the bottom of the well.

•

Proceed immediately to Bio-Rad® CFX 96 Real Time PCR Instrument.

2.8 Instrument setup
a) Turn on the Bio-Rad® CFX96 instrument and the connected computer.
b) Run the Bio-Rad® CFX MaestroTM 4.1 Software on a Microsoft® Windows PC computer
connected to the Bio-Rad® CFX96TM instrument.
•

Go to File > New > Protocol > Input the run information as shown in Table 4.

•

Set the Sample Volume to 20 μL.

•

Set the Lid Temperature to 105°C.
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c) Program the instrument to collect fluorescent data in the SYBR/FAM channel in 15 second
intervals during a 30-minute incubation at 65°C.
•

The isothermal reaction does not involve temperature cycles. Instead, the instrument is
programmed to proceed at a single temperature (65°C) for 30 minutes.

•

Fluorescence data are captured in the SYBR/FAM channel every 15 seconds. The
CFX96TM instrument requires 8 seconds to capture fluorescent information. The cycle
time (time between fluorescent readings) is therefore set to 7 seconds, resulting in
fluorescent readings at 15 second intervals.

•

The fluorescent dye can autofluoresce as it is initially heated to 65°C. To avoid
occasional issues with the automatic baseline detection when using the Bio-Rad® CFX
MaestroTM 4.1 Software, the manufacturer recommends running an initial 65C step for
2 minutes and 15 seconds without collecting fluorescence data, as shown in Table 4.
The first data are therefore collected at 2 minutes and 30 seconds.

Table 4. MICA Program for the Bio-Rad CFX96TM Instrument
Step

Temperature

Time

Cycles

1

65°C

2:15

1

2

65°C

0:07

111

Fluorescent Reading
No reading
Detection in FAM/SYBR Channel after each cycle

d) Select the fluorescent channel.
•

Go to Plate > Edit Selected > Set Fluorophores

•

Select the FAM/SYBR fluorescence channel.

e) Designate the wells that contain clinical samples.
•

Select all wells that contain clinical specimens.
o Set the sample type as “Unknown”.

•

Select only the clinical sample wells that contain SARS CoV-2 Primers.
o Check the box to load SYBR as the fluorophore and enter “SARS COV-2” as the
Target Name.

•

Select only the clinical sample wells that contain SIC Template and Primers.
o Check the box to load SYBR as the fluorophore and enter “SIC” as the Target
Name.

f) Designate wells G11 and G12 as the CoV-2 Template Controls (CTC).
•

Select wells G11 and G12.

•

Select “Positive Control” from “Sample type”.

•

Check the box to load SYBR as the fluorophore and select “SARS COV-2” as the
Target Name.
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g) Designate wells H11 and H12 as the No-template Negative Controls (NTC).
•

Select wells H11 and H12.

•

Select “Negative Control” from “Sample type”.

•

Check the box to load SYBR as the fluorophore and select “SARS CoV-2” as the Target
Name.

h) Specify the plate type.
•

Go to Settings > Plate Type > Select BR white.

2.9 Initiate the run
a) Load the plate.
•

Place the 96-well plate prepared in Section 2.7 onto the instrument block.

•

Check that the plate is oriented correctly in the instrument heat block, with well A1 in
the top left corner, as indicated by the red arrow in Figure 1.

Figure 1. Plate orientation for the
Bio-Rad® CFX96TM instrument.

b) Start the run.
•

Go to Start Run > Select Block Name (the PCR instrument).

•

Select Close Lid and Start Run.

c) Note: Once you have programmed the first run, you can re-use the programmed conditions
for subsequent runs.
•

Double click on a previous run file and select File > Repeat Run.

•

Go to Plate tab > set Control and Sample information > Start Run.

•

The fluorescence channel, plate type, and volume are already saved from the previous
run.
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3. Control Materials to be Used with MICA
The MICA test kit includes a negative control (NTC), a CoV-2 Template Control (CTC), and a
positive spike-in extraction control (SIC). The negative control and the CoV-2 Template Control
are performed in duplicate on each plate. The spike-in extraction control is added to each sample
and detected using a dedicated primer set.
3.1. Negative Control: No-Template Control (NTC).
•

Two NTC reactions are included on each plate. The SARS-CoV-2 primer set should not
amplify the NTC.

•

The goal of the NTC is to detect false positives caused by reagent contamination or crossover while preparing or performing the test.

•

If NTCs are positive, any positive SARS CoV-2 sample on that plate could potentially be
a false positive and should be interpreted as inconclusive. A positive NTC does not
invalidate a negative SARS CoV-2 result, although positive NTCs should be documented
and monitored.

3.2. Positive Control 1: CoV-2 Template Control (CTC).
•

Two CTC reactions are included on each plate. The SARS CoV-2 primer set should
amplify the CTC template.

•

The goal of the CTC is to detect false negative results caused by errors performing the test,
invalid reagents, or reaction conditions that could result in a failure to detect a positive
sample.

•

If CTCs are negative, any negative SARS CoV-2 sample on that plate could potentially be
a false negative and should be interpreted as inconclusive. A negative CTC does not
invalidate a positive SARS CoV-2 sample result, although negative CTCs should be
documented and monitored.

3.3. Positive Control 2: Spike-In Control (SIC) Template and Primers.
•

The SIC template is added to each sample before nucleic acid extraction (see Section 2.4).
The SIC primer set is expected to amplify the SIC template in every clinical sample.

•

The goal of the SIC control is to detect false negative SARS CoV-2 results caused by
problems with nucleic acid extraction or residual inhibitors in the specimen.

•

A sample is inconclusive if it is negative for both the SIC and SARS CoV-2. A negative
SIC does not invalidate a positive SARS CoV-2 result, although negative SICs should be
documented and monitored.
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E. INTERPRETATION OF RESULTS
1. Background
•

Note that the Bio-Rad® CFX96TM instrument requires 8 seconds to obtain fluorescent
measurements. Setting a 7 second cycle time plus an 8 second plate reading results in
fluorescent measurements taken at 15 second intervals.

•

The intercalating dye can autofluoresce while it is initially heated to 65°C. This could
potentially cause rare but unexpected behavior when using the automatic baseline detection
in the CFX MaestroTM 4.1 Software. The instrument program in Table 4 (Section 2.8)
therefore collects the fluorescent datapoint at 2.5 minutes (Cycle 10). Subsequent readings
are taken at 15 second intervals.

2. Fluorescent Baseline Adjustment
•

The MICA test has been validated using the automatic fluorescent baseline adjustment
using both Clear Gene MICA Software and Bio-Rad® MaestroTM 4.1 Software.

3. Signal Analysis
•

Time to amplification can be automatically determined using Clear Gene’s MICA
software, or it can be manually calculated based on the default Cq returned by the Bio-Rad®
CFX MaestroTM 4.1 Software.

•

When manually interpreting results, the Cq threshold is automatically determined by the
Bio-Rad® CFX MaestroTM 4.1 Software. A cut-off time of 30 minutes (111 cycles) is used
to distinguish positive and negative reactions for samples and controls. If manually
calculating time to amplification, remember that the first reading is taken at 2.5 minutes.

•

A sample is positive if the amplification occurs at any point during the 30-minute reaction
(fluorescent readings are obtained during cycles 10 - 111).
Table 5. Interpretation of Signal
Result

Interpretation

Cq ≤ 111 cycles (30 minutes)

Positive Signal

Cq > 111 cycles (30 minutes)

Negative Signal

4. Plate Controls
Examine and interpret plate controls before interpreting clinical samples or sample controls.
4.1. Negative Control (NTC). NTCs detect potential false positive results. If NTCs are
positive, any SARS CoV-2 samples on that plate with a positive result are considered
inconclusive and should be repeated. A positive NTC does not invalidate a negative
SARS CoV-2 result.

12

•

Positive results from an NTC reaction may be caused by cross-over while performing the
test, an incomplete plate seal, or cross-contamination of instruments or reagents. The
manufacturer recommends root-cause analysis to determine whether updated training
protocols or decontamination protocols are warranted.

•

When warranted, decontamination protocols should include cleaning pipettes, supplies,
equipment and work station thoroughly with bleach or a decontaminant reagent, such as
DNA AWAY™. Repeat the run using a fresh aliquot of reagents with strict adherence to
the guidelines.

•

Be advised that an incomplete plate seal can cause positive NTC results. This has been
observed when supply shortages impact the selection of the PCR plate and adhesive film.
Exercise caution when selecting alternate plates; these can have different surface coatings or
textures, even when they visually appear similar to the recommended plates. If supply shortages
force consumable substitutions, be sure to validate the combination of substitute plates together
with the adhesive film, carefully evaluating whether amplicons from positive wells cross over to
adjacent NTC wells.

4.2. CoV-2 Template Control (CTC). The CTC detects potential false negative results
caused by amplification failures. If CTCs are negative, any negative SARS CoV-2
sample on that plate is interpreted as inconclusive and should be repeated. A negative
CTC does not invalidate a positive SARS CoV-2 result in the corresponding sample.
•

If investigation of negative CTCs is warranted, begin by repeating the NTC and CTC
reactions using a fresh aliquot of reagents with strict adherence to the protocol and
laboratory guidelines.

•

Failure to amplify the CTC could be caused by an incompletely mixed plasmid template
or by shearing the plasmid template, for example by aggressive vortexing.
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5. Samples and Sample Controls
After interpreting the plate controls (Section H.4), refer to Table 6 to interpret the SARS CoV-2
reactions and the corresponding Spike-in Controls (SIC) for each clinical sample.
Table 6. Interpretation of Sample Results. The SARS CoV-2 column refers to wells with clinical samples that
contain the Reaction Mix and SARS CoV-2 primer sets. Every clinical sample also includes a corresponding well with
Reaction Mix and the Spike-In Control (SIC) primer set.
SARS CoV-2

SIC

Interpretation

Positive

Positive

SARS-CoV-2
DETECTED

Report positive results to physician, patient, and
appropriate public health authorities.

Positive

Negative

SARS-CoV-2
DETECTED

Report positive results to physician, patient, and
appropriate public health authorities.

Negative

Positive

SARS-CoV-2
NOT Detected

Report negative results to physician, patient, and
appropriate public health authorities.

INCONCLUSIVE

Repeat the test steps in G.2 using residual clinical
samples. If the result remains inconclusive, report
inconclusive results to ordering physician,
manufacturer, and appropriate public health
authorities.

Negative

Negative

Action
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F. MICA TEST COMPONENTS
1. Components Included with the Test
Table 7. Kit Components.
Reagent

Storage

MICA Master Mix (2X)
SARS-CoV-2 Primer Mix (10X)
Spike-in Control (SIC) Primer Mix (10X)

Store at -20°C

CoV-2 Template Control (CTC)
Spike-in Control (SIC) Template
Nuclease-free Water

Room temperature or -20°C

2. Components Required but not Included with the Test Kit
•
•

•

•

•

•
•
•
•

Consumables to collect and transport upper respiratory tract specimens
Kit to extract RNA from clinical specimens
o Quick-DNA/RNA™ Viral MagBead extraction kit
(Zymo Research, Catalog No. R2141)
o QIAamp® DSP Viral RNA Mini Kit
(QIAGEN, Catalog No. 61904)
Real-time PCR system
o CFX96TM Touch Deep Well Real-Time PCR Detection System
(Bio-Rad®, Catalog No. 1854095)
o Microsoft® Windows PC running CFX Maestro 4.1 Software
(Bio-Rad®, Catalog No. 12005258)
Centrifuge capable of generating 500 x g for 30 seconds, with bucket adapter for PCR plate.
Avoid plate spinners that load vertically. Refrigeration is not required.
o Example Centrifuge: 5920 R (Eppendorf®, Catalog No. 5948000131)
o Example Rotor: M10 Microplate Swinging Bucket Rotor
(Thermo, Catalog No. 75005706)
96-well white PCR plates. Please note that white plates are preferred.
o twin.tec® 96 real-time PCR Plate: Skirted, 150 μL, PCR clean, Blue, White Wells
(Eppendorf® Catalog No. 951022003)
Sealing Film (Bio-Rad® MSB 1001 or equivalent)
Pipettes, vortex and benchtop microcentrifuge
Cold block for PCR plate that maintains a temperature between -20°C and 7°C
o Example: IsoTherm-System® (Eppendorf® Catalog No. 0225100530)
Sterilized DNase/RNase-free pipette tips with filter (10 μL, 20 μL and 200 μL)
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•
•

1.5 mL DNase/RNase free microcentrifuge tubes and racks
Disposable powder-free gloves and laboratory gowns
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